
User’s Manual
T-Shirt Vital Jacket® HWM

Heart Wave Monitor
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produced or translated into another language without the prior au-
thorization of Biodevices, SA. The manufacturer reserves the right to 
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Product Information
T-Shirt Vital Jacket HWM

Fig. 1 - Contents of the Vital Jacket box.

1. T-Shirt
The T-Shirt has 3 springs where the signal acquisition electrodes should be connected. This 

T-Shirt also has a plug, inside of a pocket, where the electronic device should be connected.

2. Electronic Device
The electronic device allows acquiring the Electrocardiogram (ECG) signal and the heart 

rate. All data acquired will be stored in a SD Card (provided as accessory). Furthermore, 

this device has Bluetooth communication for sending/receiving data. The electronic device 

has 3 LEDs that indicate the state:

>  Red LED: heart rate.

>  Green LED: device charging.

>  Blue LED: Bluetooth connected.

3. HWM Applications: PDA & Desktop

The PDA application, VJ_Mobile, allows on-line viewing of the ECG signal and the user’s heart rate. The data received in the PDA, via Bluetooth, 

is stored in files in a SD Card contained in the PDA. This application also allows adding events/notes during the exam. At the end of the 

exam, the user can view a summary of the exam that is shown as a heart rate histogram. All data stored in the SD Card of the PDA can be 

synchronized with the PC.

The Desktop application, VJ_Desktop, synchronizes data from the SD Card of the PDA or from the SD Card of the electronic device. This application 

allows viewing exams already done. The VJ_Desktop application has a set of algorithms to process data, which the user can use.
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Battery charging and charger

To charge the battery of the electronic device, it should be connected to the battery 

charger provided. The green LED (power supply) should switch on. While this LED is 

on, the device is charging.

Accessories 

A SD Card will be provided to be used in the electronic device. The VJ_Desktop application allows programming the SD Card.

A set of 25 electrodes will also be provided for the first usages. The electrodes can be bought from Biodevices, SA, by order or at a 

specialized store.

We call your attention for the fact that the system was tested with electrodes provided by Biodevices, SA. Biodevices, SA does not 

take any responsibility for any bad results resulting from the use of other electrodes.

Fig. 2 - Appearance of the electronic device.
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Safety Precautions

Handling Scope
The HWM Vital Jacket® T-Shirt is an ECG signal and heart rate monitoring system.

The HWM Vital Jacket® is not a medical device and, as such, it cannot be used for therapeutic or diagnosis purposes.

Symbols

Symbol Description

Bluetooth

Caution

Information

Recyclable packing

Non-recyclable electronic device, in accordance with 2002/96/EC directive

Device in accordance with 2002/95/EC directive

Electronic device in accordance with 2006/95/EC directive, 2004/108/CE directive and 1999/5/CE directive

FCC ID:
WDPHWM-001

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this 

device may not cause harmful interference, and (2) this device must accept any interference received, including 

interference that may cause undesired operation
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Disclaimer of responsibility 

The HWM Vital Jacket® T-Shirt was designed to be used both for leisure and sports. It should not be used as medical equipment. Its handling 

should comply with the instructions described in the user’s manual provided.

Athletes should take into account that setting the maximum heart rate is a key element while programming training. Therefore, they should 

seek advice near their doctor to define the maximum heart rate, their higher and lower heart limit values, as well as the frequency and 

duration of training.

Non-compliance with these precautions can put the user’s health at risk.

Warranty

Biodevices, SA guarantees that the HWM Vital Jacket® T-Shirt is free from material or manufacture defects for a period of 2 years from the 
date of the purchase (except for the battery). For that purpose, the owner should make proof of purchase.

> The warranty does not cover damages caused by repairs done by people or agents not authorized by Biodevices, SA. 

> The warranty does not cover damages caused by bad handling, accidents, or incorrect maintenance of the HWM Vital Jacket® T-Shirt.

> The warranty does not cover cracked, broken boxes or that present signs of visible impacts.

> Do not open the electronic device. Such violation will render the warranty null and void.

Handling Safety Precautions  

>  Read the user’s instructions provided before using the HWM Vital Jacket® T-Shirt.

>  The Bluetooth symbol, in relief on the electronic device box, should be facing the outer part of the T-Shirt.

>  The electronic device should be charged while it is out of the T-Shirt.

>  Handle the electronic device carefully, do not drop it, and do not submit it to big impacts.

>  Do not to put the electronic device in contact with water.
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Cleaning and Disinfection Requirements
Remove the electronic device before washing the T-Shirt.

Washing instructions:

Machine wash up to 30º C/86º F

Do not bleach

Iron up to 110º C / 230º F

No tumble dry

No dry clean
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Vital Jacket® T-Shirt Preparation and Handling Instructions

Fig. 4 – ActiveSync 4.5 (Windows XP).

1. VJ_Mobile and VJ_Desktop Software Installation

Before using the HWM Vital Jacket® for the first time, the user has to install the software, provided 

in the CD, in the PDA and in the PC Desktop.

Installation walkthrough:
a. PC requirements:

The VitalJacket Desktop application needs .NET Framework 2.0 or superior version that is available 

in the installation CD, if needed.

b. PDA requirements:

The VitalJacket Mobile application only runs on Windows Mobile 5.0 or superior version. It also needs 

.NET Framework 2.0 or superior version that is available in the installation CD, if needed.

c. How to install?

1. Run the installation CD and select the desired version;

2. Click Check Now to check if you have .NET Framework 2.0;

3. Install/update .NET Framework 2.0 if needed. Otherwise click Proceed Installation (Fig. 3);

4. Click on VitalJacket Desktop to install the application. Follow the given instructions until the ap-

plication is properly installed;

5. Run the installation CD again to install VitalJacket Mobile application following the instructions 

until step 3;

6. Click on VitalJacket Mobile to install the application. It will be asked to check which software you 

have to synchronize your PDA with the PC. If you don’t have ActiveSync 4.5 (Windows XP users) 

(Fig. 4) or WM Device Center 6.0 (Windows Vista users) (Fig. 5), you need to install it by clicking on 

ActiveSync 4.5 or WM Device Center 6.0. Otherwise click Proceed Installation and follow the given 

instructions until the application is properly installed.

Fig. 5 – Windows Mobile Device Center 
(Windows Vista).

Fig. 3 - Installation Main Menu
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Putting on the T-Shirt and connecting it to the electronic device.

1. Put on the T-Shirt.

2. Place the electrodes on the body:

2.1. The areas where the electrodes will be placed (Fig. 6) should be free 
from dirt and skin oil. Clean those areas with alcohol, if necessary.

2.2. Remove the electrodes’ cover and then place them on the body in the 
appropriate locations.

2.3. Connect the electrodes to the T-Shirt springs (Fig. 7). Fig. 6 –Location of the electrodes in the body.

Fig. 7 – Connecting an electrode to a T-Shirt spring.

NOTE: After placing the electrodes, it may be necessary to wait a few 

minutes for the system to start working properly. This is normal, because 

the electrodes need some time to come into good contact with the skin.

  The incorrect preparation of the skin can lead to cardiac 
signal failure.
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3. To setup the SD Card: if the SD Card is not configured, the user should use the VJ_Desktop application to configure the SD Card:

3.1. Put the SD Card in the PC Desktop where the VJ_Desktop application is installed.

3.2. Launch the VJ_Desktop application.

3.3. In the Tools menu select the Format Card option (Fig. 8).

3.4. Press the Options button (Fig. 9) and then select 

the Card Setup option (Fig. 10) to check the SD Card 

setup options.

3.5. Click on Format SD Card.

4. After finishing the SD Card setup, remove the SD 
Card from the PC and put it in the electronic device.

Fig. 8 – VJ_Desktop application – Format SD Card option. Fig. 9 – VJ_Desktop application – SD Card setup.

Fig. 10 – VJ_Desktop application – SD Card configuration parameters.



12

5. Connect the electronic device to the T-Shirt:

5.1. Open the T-shirt pocket and pull the plug out of the pocket (Fig. 11).

5.2. Connect the electronic device to the T-Shirt plug (Fig. 12).

5.3. The red LED of the electronic device (Fig. 2) should start blinking (the acquisition of the ECG signal and heartbeat rate began). To assure 
the system is working properly, one can compare the rhythm of the LED with his/her own heartbeat. These two signals should be synchro-
nous.

NOTE: All data acquired by the electronic device is stored in a file in the SD Card. The SD Card has capacity to store data for several hours, 
approximately 72 hours, without Bluetooth connection.

6. Keep the electronic device inside the T-Shirt pocket (Fig. 13).

NOTE: The Bluetooth symbol, in relief on the electronic device box, should be facing the outer part of the T-Shirt.

7. Close the T-Shirt pocket.

Fig. 11 – Opening the T-Shirt pocket and removing 
the connecting plug.

Fig. 12 –  Connecting the electronic device to the 
T-Shirt plug.

Fig. 13 – Storing the electronic device in the T-Shirt 
pocket.
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Viewing/Acquisition of an on-line exam in the PDA:

1. Turn on the PDA.

NOTE: Check the PDA battery charge level.

2. Launch the VJ_mobile application in the PDA (Fig. 14).

3. Setting up VJ_Mobile application.

The first time the application is used, the user will have to setup the Bluetooth connection to the electronic device and to carry out its 

identification. The next time the VJ_Mobile application is used, the setup data entered by the user will be automatically configured by the 

application.

3.1. Setting up Bluetooth connection to the electronic device: the application searches within the PDA range all Bluetooth electronic devices 

of the VJ (Vital Jacket®) type, (Fig. 15). The electronic devices found will be shown in the list of VJ devices (Fig. 16 - 1). The user has to select 

the electronic device he wants and then save the new settings (Fig. 16 – 2). From that moment on, the application will be configured for the 

VJ electronic device selected. Then, the application will launch the user identification form.

Fig. 14 – VJ_Mobile, launching 
the application in the PDA.

Fig. 15 –  VJ_Mobile, searching 
VJ electronic devices.

Fig. 16 – VJ_Mobile, 1. list of VJ electronic devices 
found  2. saving new Bluetooth setup.
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The user will be informed if there is no electronic Bluetooth device of the VJ (Vital Jacket®) type connected within the PDA range (Fig. 17). The 

user should check if the electronic device is connected (the red LED in the electronic device should be blinking), and then make a new search 

by pressing the New Search image.

3.2. User identification (Fig. 18 - 1), initial form:

To setup a new user in the application, click on the user image for 3 seconds and select the 

New User option (Fig. 19). The user identification fields will be cleaned.

4. To continue, press the Next function key. A form will appear where other user informa-

tion, such as blood pressure, weight, height, etc., can be filled in. The aim of this optional 

information is to record the progress throughout the sessions (later on it will be passed on 

to the PC software, VJ_Desktop) (Fig. 20).

Fig. 17 – VJ_Mobile, VJ elec-
tronic devices not found.

Fig. 18 – VJ_Mobile, 1. user identification form, 2. date 
of birth entry form.

Fig. 19 – VJ_Mobile, setting up 
the application for a new user.

Fig. 20 – VJ_Mobile, form to 
enter other user information.
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5. To start an exam viewing/acquisition, press the Next function key. The user will be informed if there is no SD Card in the PDA. In this case, 

it will not be possible to save the exam data in the PDA, but the user can still continue viewing the exam in the PDA. While the Bluetooth 

connection between the PDA and the electronic device is setting up, an indication to wait a moment is shown on the PDA screen (Fig. 21).

5.1. The user is informed if the Bluetooth connection between the PDA and the electronic device fails. The user should check if the electronic 

device is connected (the red LED in the electronic device should blink) and try to reconnect the devices (Fig. 22).

The first time the electronic device is connected to the PDA, it may be necessary to setup the Bluetooth connection in the PDA. The PDA will 

ask the user to enter a 4-digit PIN to authenticate the Bluetooth connection, (Fig. 23 – 1). The user must enter ‘0000’ and press the Next 

function key. From that moment on, there is an authenticated Bluetooth connection between the PDA and the electronic device. The PDA can 

also ask the user to select the electronic device service he wants to connect to, (Fig. 23 – 2). The only active service in the electronic device 

is the Serial Port, so select that service and press the End function key to finish the authentication process.

6. The Bluetooth connection between the PDA and the electronic device is made (Fig. 24).

Fig. 23 – VJ_Mobile, Bluetooth connection setup, 1. 
Access Code, 2. Available Services.

Fig. 21 – VJ_Mobile, connecting 
Bluetooth with electronic device.

Fig. 22–VJ_Mobile, Bluetooth connection 
with the electronic device failed. Fig. 24 – VJ_Mobile, Bluetooth connection 

with the electronic device is made.



16

Fig. 25 – VJ_Mobile, start exam.

Fig. 26 – VJ_Mobile, end exam. Fig. 27 – VJ_Mobile, exam 
summary.

Fig. 28 – VJ_Mobile, add an 
event to the exam.

Fig. 29 – VJ_Mobile, predefined events available in the application.

NOTE: It is possible to acquire/view an exam in the PDA for several hours, depending on the PDA battery 

and on the battery of the electronic device. The PDA battery can be charging while the exam acquisition/

viewing is taking place. Connect the PDA to the charger or to a PC via a USB cable. The user can monitor 

the level of the PDA and of the electronic device batteries.

7. To start acquiring/viewing the ECG signal and the heartbeat rate, press the Start Exam function key. The 

ECG signal should start being drawn, as well as the heartbeat rate should be shown on the PDA screen 

(Fig. 25).

8. To finish an exam acquisition/viewing, press the End Exam function key (Fig. 26).

9. If the user wants, at the end of the exam, it is possible to view a summary of the exam carried out (Fig. 27). Pressing the Exit function 
key, the application returns to the initial form (Fig. 18).

10. While an exam is taking place, the user can add Events and Bookings to the exam.

10.1. To add an event to the exam:

10.1.1. Click on the Add New Event image (Fig. 28).

10.1.2. A set of predefined events, such as cardiovascular work, neuromuscular work and relaxation are shown. It is also possible to add a 
new event with the Other option (Fig. 29).
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Fig. 30 – VJ_Mobile, launch 
event.

Fig. 31 – VJ_Mobile, end 
event.

Fig. 32 –  VJ_Mobile, add 
booking to the exam.

Fig. 33 – VJ_Mobile, form to 
add booking.

Fig. 34 – VJ_Mobile, save 
booking entered in the exam.

Fig. 35 –  VJ_Mobile, chang-
ing the application idiom.

10.1.3. Select the event you want and click on the launch events image (Fig. 30). From that moment on an event is launched. The PDA sends 
a beep at the beginning of the event.

10.1.4. To finish the event previously launched, click on the image to end the events (Fig. 31). The PDA sends a beep at the end of the 
event.

10.2. During an exam it is possible to add a booking at a specific moment of the acquisition:

10.2.1. Click on the Add a new booking image (Fig. 32).

10.2.2. The user should write in the text box (Fig. 33) the text that he wants to associate to the booking.

10.2.3. To add the booking to the exam, click on the image to save (Fig. 34).

10.2.4. The booking can be cancelled at any time. To do that, click on the booking cancellation image (Fig. 34).

11. Changing the application language:

11.1. To change the PDA application language click on the image for 3 seconds, select the Language menu option, and then select the lan-
guage you want (Fig. 35).
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12. Re-setting up the Bluetooth connection:

12.1. To re-configure the Bluetooth connection in the application, click on the setup image for 3 seconds, and select the Bluetooth Setup 
menu option (Fig. 36).

12.2. The other steps to setup a new Bluetooth connection were described in point  3.1 – Setting up Bluetooth connection to the electronic device.

13. The application allows viewing summaries/results of the exams already done. In the initial form (Fig. 18), click on the setup image for 
3 seconds, and select the Open Exam menu option (Fig. 37 – 1). A new form to select the exam will be launched (Fig. 37 – 2). Pressing the 
Exit function key, the application returns to the initial form (Fig. 18).

To select the exam to open, press the Open Exam function key. A new form to select the exam will be launched (Fig. 38 – 1). All exams in the 
PDA will be shown. The user just has to select the exam he wants to view by clicking on the exam he wants. The user will have to wait for a 
few moments while the exam data is being processed (Fig. 38 – 2).

Fig. 36 – VJ_Mobile, setting up 
Bluetooth connection.

Fig. 37 – VJ_Mobile, 1. open an exam, 2. form to view the 
exam summary.

Fig. 38 – VJ_Mobile, 1. selecting exam to open, 2. exam to open.
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4. Viewing an exam and synchronizing the SD Card

1. Launch the VJ_Desktop application in the PC (Fig. 39).

2. To synchronize the SD Card exams with the PC, insert the SD Card in the PC card reader where the VJ_Desktop application is installed. Se-

lect the Search option in File menu (Fig. 40). Pressing the Import from Card button will transfer all the exams in the SD Card to the PC. After 

this synchronization process, the SD Card is configured again so that it can be used in the electronic device to carry out new exams.

Fig. 39 – Appearance of the VJ_Desktop application. Fig. 40 – VJ_Desktop, synchronizing SD Card.
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3. To view an exam, select the Open option in the 

File menu (Fig. 41). After having selected the exam 

to be viewed, a user identification form is launched 

(Fig. 42).

The application enables a set of tools/options that 

the user can use while viewing the exam (Fig. 43):

> To zoom in/out the ECG signal;

> To add a grid to the exam, to facilitate its viewing;

> To add a ruler to measure the distances between 

ECG signal points (Fig. 44);

> To view the events in the exam (Fig. 45).

Fig. 41 – VJ_Desktop, opening a new exam. Fig. 42 – VJ_Desktop, user identification. Fig. 43 – VJ_Desktop, viewing the exam.

Fig. 44 – VJ_Desktop, adding ruler to the exam to make mea-
surements.

Fig. 45 – VJ_Desktop, viewing all events in the exam.
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4. The VJ_Desktop application allows adding new events to the exam. In order to do that, select 

with the mouse the exam area where you want to associate the event (Fig. 46). Press the Save 

button to save the event. This event will be added to the exam (Fig. 47).

5. Selecting the Edit menu and the Exam Information option, the user can view an exam summary 

(Fig. 48).

6. The VJ_Desktop application also has a functionality to make reports, in the Report option in 

the Tools menu. In that report you will find all information associated with the exam selected: 

user identification, heartbeat rate data, as well as a heartbeat variation histogram, etc. (Fig. 
49).

Fig. 46 – VJ_Desktop, add new event. Fig. 47 – VJ_Desktop, event added to the exam. Fig. 48 – VJ_Desktop, exam summary.

Fig. 49 – VJ_Desktop, exam report.
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Troubleshooting and Corrective Measures

Problem Cause Corrective Measure

No signal or heartbeat rate.
The electrodes are misplaced.

Check the position of the electrodes according to the 

instructions provided in the User’s Manual.

The electrodes are not wet enough.
Dampen the electrodes with water or with an appor-

priate conductive gel.

The electronic device will not turn on.

The electronic device battery is low or 

completely worn out.
Charge the electronic device battery.

The SD Card is not in the electronic de-

vice.
Put the SD Card in the electronic device.

Incorrect configuration of the SD Card.
You must configure the SD Card in the VitalJacket 

Desktop application provided.

The signal and the heartbeat rate are 

out of control.

Incorrect placement of the electronic de-

vice.

The electronic device should be placed inside the pock-

et with the Bluetooth symbol facing out.

Bad contact of an electrode. Make sure all the electrodes are properly connected.

The PDA is not able to connect with 

the electronic device.
The electronic device is switched off.

Make sure the electronic device is on (red LED should 

be blinking).

Red LED of the electronic device is 

not blinking.

Bad contact of the SD Card.
Remove the SD Card from the electronic device and 

insert it again.

Misconfiguration of the SD Card.
You must configure the SD Card in the VitalJacket 

Desktop application provided.

SD Card files without space.
You must synchronize the SD Card with the PC and 

configure it again.
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The packing is made of 100% recyclable material and it contains the respective symbol.

For its disposal, it is mandatory to comply with a certain number of rules on packing legislation. The packing material (plastic bags, etc.) should 

be kept out of the children’s reach, given that it is potentially dangerous.

This electronic device complies with the European Directives 2002/96/EC, Waste Electrical and Electronic Equipment (WEEE) and 2002/95/

EC, Restriction of Hazardous Substances (RoHS). The symbol contained in the product or documentation indicates that rather than handling 

this product as household waste it should be delivered at specialized centres that collect and recycle electrical and electronic equipment. 

Dispose of it in accordance with the national legislation.

For information on handling, recovery and recycling this product, contact the respective centre in your local area, the household waste pick up 

service, or the shop where this product was purchased.

1. Packing

2. Electronic Device

Environmental Information
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Electronic Device:

1. Dimensions:

61 x 34 x XX mm

2. Weight (including rechargeable batteries):

xxg

3. Communication Specifications (Bluetooth v2.0):

Power supply: xxW

Rate: 2,4GHz

Range: 10m linha directa

4. Transport and Storage Specifications:

5. Especificações de Operação:

Specifications

Temperature

Temperature

without condensation

to

to

Humidity

Humidity

Air Pressure

Air Pressure

Consumption

Autonomy

without condensation

to

wash

Machine wash up to 30º C/86º F

Do not bleach

Iron up to 110º C / 230º F

No tumble dry

No dry clean
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Any repair and technical service should be carried out by a Biodevices, SA Authorized Service Centre. 

Biodevices, Sistemas de Engenharia Biomédica, S.A.

Head office:
Campus Universitário Santiago, Pav.1

3810-193 Aveiro

Offices:
Rua 5 de Outubro, 309

4150-175 Porto

Portugal

Contacts:
Tel.: +351 220 902 540

Fax: +351 220 165 492

Email: info@biodevices.pt

Customer service and support 
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Coding of the elements and accessories set

T-Shirt

PCB

Battery charger

SD Card

User’s Manual

CD with Software

Electrodes

Description Code
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Manufacturer’s Declarations
European Requirements 

Directives
2006/95/EC DIRECTIVE

Low voltage equipment (LV)

2004/108/EC DIRECTIVE

Electromagnetic compatibility (EMC)

1999/5/EC DIRECTIVE

Waste from Electrical and Electronic Equipment (R&TEE)

2002/95/EC DIRECTIVE

Restriction of Certain Hazardous Substances (RoHS)

2002/96/EC DIRECTIVE

Waste electrical and electronic equipment (WEEE)

Harmonized Standards
ETSI EN 300 328 V1.7.1

Electromagnetic compatibility and Radio spectrum Matters (ERM); Wideband transmission systems; Data transmission equipment op-

erating in the 2,4 GHz ISM band and using wide band modulation techniques;

EN 301 489 part 1&17 V1.4.1

ElectroMagnetic Compatibility (EMC) standard for radio equipment and services; Part 17: Specific conditions for 2,4 GHz wideband 

transmission systems and 5 GHz high performance RLAN equipment.

EN 60950-1:2006 

Information technology equipment. Safety. General requirements
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USA Requirements

Requirements
FCC radio certification

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause 

harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired opera-

tion. 


